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12.Click the View button and the Data Recorder appears, displaying 
the new values of the variables. 

13.Record the process variables for Overflash rates of 5500 and 
7500 barrels/day. Enter names for these variable states of 5500 
O.F. and 7500 O.F., respectively. The final Data Recorder appears 
below.

14.Save your case by doing one of the following:

• press CTRL S.

• from the File menu, select Save.

• click the Save icon.

2.3 Dynamic Simulation
In this tutorial, the dynamic capabilities of UniSim Design are 

incorporated into a basic steady state oil refining model. A simple 

fractionation facility produces naphtha, kerosene, diesel, atmospheric 

gas oil, and atmospheric residue products from a heavy crude feed. In 

the steady state refining tutorial, preheated crude was fed into a pre-

flash drum which separated the liquid crude from the vapour. The liquid 

crude was heated in a furnace and recombined with the vapour. The 

combined stream was then fed to the atmospheric crude column for 

fractionation. The dynamic refining tutorial only considers the crude 

column. That is, the crude preheat train is deleted from the flowsheet 

 Figure 2.143

 Figure 2.144

Save icon

This complete dynamic 
case has been pre-built 
and is located in the file 
DynTUT2.usc in your 
UniSim Design\Samples 
directory.
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and only the crude column in the steady state refining tutorial is 

converted to dynamics.

The main purpose of this tutorial is to provide you with adequate 

knowledge in converting an existing steady state column to a dynamics 

column. The tutorial provides a single way of preparing a steady state 

case for dynamics mode, however, you can also choose to use the 

Dynamic Assistant to set pressure specifications, size the equipment in 

the plant, and/or add additional equipment to the simulation flowsheet.

This tutorial comprehensively guides you through the steps required to 

add dynamic functionality to a steady state oil refinery simulation. To 

help navigate these detailed procedures, the following milestones have 

been established for this tutorial.

1. Obtain a simplified steady state model to be converted to dynamics.

2. Implement a tray sizing utility for sizing the column and the side 
stripper tray sections.

3. Install and define the appropriate controllers.

4. Add the appropriate pressure-flow specifications.

5. Set up the Databook. Make changes to key variables in the process 
and observe the dynamic behaviour of the model.

2.3.1 Simplifying the Steady State 
Flowsheet

In this section, you will delete the preflash train in the steady state 

simulation case R-1.usc:

 Figure 2.145

In this tutorial, you 
follow this basic 
procedure in building the 
dynamic model.
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1. Open the pre-built case file R-1.usc. The crude column simulation 
file R-1.usc is located in your UniSim Design\Samples directory.

2. Press F4 to make the Object Palette visible.

For the purpose of this example, the Session Preferences are set so 

that the Dynamic Assistant will not manipulate the dynamic 

specifications.

3. From the Tools menu, select Preferences. The Session Preference 
view appears.

4. On the Simulation tab, select the Dynamics page. 

5. Deactivate the Set dynamic stream specifications in the 
background checkbox.

6. Click the Variables tab, then select the Units page.

7. In the Available Unit Sets group, select SI.

8. Click the Close icon  to close the Session Preferences view. Close 
all other views except for the PFD view.

9. Add a material stream to the PFD by doing one of the following:

• From the Flowsheet menu, select Add Stream.

• Double-click the Material Stream icon on the Object Palette.

10. In the Stream Name cell, type Store. This stream will be used to 
store information from the Atm Feed stream.

 Figure 2.146

 Figure 2.147

In this tutorial, you are 
working with SI units. 
The units are changed 
by entering the 
Preferences property 
view in the Tools menu 
bar. In the Units tab, 
specify SI in the Current 
Unit Set group.
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11. In the Store stream property view, click the Define from Other 
Stream button. The Spec Stream As view appears.

12.Select Atm Feed in the Source stream group.

13.Click on the OK button to copy the Atm Feed stream information to 
the Store stream.

14.Close the Store stream view.

 Figure 2.148

 Figure 2.149
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15.Delete all material streams and unit operations upstream of the Atm 
Feed stream. The following eight items should be deleted:

After you delete the above items, stream Atm Feed is not fully 

specified.

16.Double-click the Atm Feed stream icon to open its property view.

17.Click the Define from Other Stream button. The Spec Stream As 
property view appears.

18.Select Store in the Source Stream group and click OK.

19.Close the Atm Feed stream view, then delete the stream Store.

This steady state case now contains the crude column without the 

preflash train. Since the identical stream information was copied to 

stream Atm Feed, the crude column operates the same as before 

the deletion of the preflash train.

20.Save the case as DynTUT2-1.usc.

Make sure that the Standard Windows file picker radio button is 

selected on the File page in the Session Preferences view. 

Items to be deleted

Material Streams Energy Streams Unit Operations

Hot Crude

PreFlsh Liq

PreFlsh Vap

Raw Crude

Crude Duty PreFlash Separator

Crude Heater

Mixer

 Figure 2.150

When you delete a 
stream, unit or logical 
operation from the 
flowsheet, UniSim 
Design asks you to 
confirm the deletion. If 
you want to delete the 
object, click the Yes
button. If not, click the 
No button.

For more information on 
Session Preferences 
please refer to Section 
12.5 - Files Tab in the 
UniSim Design User 
Guide.
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2.3.2 Adding Equipment & Sizing 
Columns

In preparation for dynamic operation, the column and side stripper tray 

sections and surrounding equipment must be sized. In the steady state 

scenario, column pressure drop is user specified. In dynamics, it is 

calculated using dynamic hydraulic calculations. Complications arise in 

the transition from steady state to dynamics if the steady state 

pressure profile across the column is very different from that calculated 

by the Dynamic Pressure-Flow solver.

The Cooler operations in the pump arounds are not specified with the 

Pressure Flow or Delta P option, however, each cooler must be specified 

with a volume in order to run properly in dynamic mode.

Column Tray Sizing
1. Open the Utilities property view by pressing CTRL U.

The Available Utilities view appears.

2. Scroll down the list of available utilities until the Tray Sizing utility is 
visible.

 Figure 2.151
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3. Select Tray Sizing, then click the Add Utility button. The Tray Sizing 
view appears. 

4. In the Name field, change the name to Main TS.

5. Click the Select TS button. The Select Tray Section view appears.

6. In the Flowsheet list, select T-100, then select Main TS in the 
Object list. Click the OK button.

7. In the Use Tray Vapour to Size drop-down list, select Always Yes.

 Figure 2.152

 Figure 2.153



Refining Tutorial 2-109

2-109

8. Click the Auto Section button. The Auto Section Information view 
appears. The default tray internal types appear with the Valve type 
selected.

9. Keep the default values and click Next. The next view displays the 
specific dimensions of the valve-type trays.

10.Keep the default values and click the Complete AutoSection
button.

UniSim Design calculates the Main TS tray sizing parameters based 

on the steady state flow conditions of the column and the desired 

tray types.

Two tray section sizes, Section_1 and Section_2, appear in the 

 Figure 2.154

 Figure 2.155

The Valve tray type is 
selected as the default 
option. This option is 
entered into the Main 
TS property view.
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Setup page of the Design tab. Section_1 includes trays 1 to 27; 

Section_2 includes trays 28 and 29. Since there are different 

volumetric flow conditions at each of these sections, two different 

tray section types are necessary.

11.Click the Design tab, then select the Specs page.

12.  In the Number of Flow Paths cell, enter 3 for both Section_1 and 
Section_2.

13.Click the Performance tab, then select the Results page to see 
the dimensions and configuration of the trays for Section_1 and 
Section_2. Since Section_1 is sized as having the largest tray 
diameter, its tray section parameters should be recorded.

14.Confirm the following tray section parameters for Section_1. 

The number of flow paths for the vapour is 3. The Actual Weir length 

is therefore the Total Weir Length recorded/3.

15.Calculate the Actual Weir length:

16.Confirm the Maximum Pressure Drop/Tray and check the number of 
trays in the Main TS column. The Total Section Pressure drop is 
calculated by multiplying the number of trays by the Maximum 
Pressure Drop/Tray.

 Figure 2.156

Variable Value

Section Diameter 5.639 m

Weir Height 0.0508 m

Tray Spacing 0.6096 m

Total Weir Length 13.31 m

Variable Value

Actual Weir Length (Total Weir Length/3) 4.44 m

Variable Value

Maximum Pressure Drop/Tray 0.86 kPa

Number of Trays 29

Total Section DeltaP 24.94 kPa
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17.Close the Tray Sizing: Main TS and Available Utilities views.

18.Double-click on the Column T-100 icon in the PFD, then click the 
Column Environment button to enter the Column subflowsheet.

19.On the column PFD, double-click the Main TS Column icon to enter 
the Main TS property view.

20.Click the Rating tab, then select the Sizing page.

21.Enter the previous calculated values into the following tray section 
parameters:

• Diameter 5.639m

• Tray Spacing 0.6096m

• Weir Height 0.0508m

• Weir Length (Actual Weir Length) 4.44m

22. In the Internal Type group, select the Valve radio button.

23.Close the Main TS property view.

24.Access the Column property view by clicking the Column Runner
icon in the tool bar.

 Figure 2.157

Be aware that the 
default units for each 
tray section parameter 
may not be consistent 
with the units provided 
in the tray sizing utility. 
You can select the units 
you want from the 
drop-down list that 
appears beside each 
input cell.

Column Runner icon
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25.Click the Parameters tab, then select the Profiles page. Observe 
the steady state pressure profile across the column.

26.Record the top stage pressure (1_Main TS). Calculate the 
theoretical bottom stage pressure as follows:

27. In the Pressure column of the Profiles group, specify a bottom 
stage pressure (29_Main TS) of 222.84 kPa.

28.Converge the Column sub-flowsheet by clicking the Run Column 
Solver icon in the tool bar.

29.Close the Column property view.

Side Stripper Tray Sizing
In this section, you will size the following side stripper operations using 

the tray sizing utility as described in the Column Tray Sizing section.

• Kero_SS

• Diesel_SS

• AGO_SS

1. From the Tools menu, select Utilities. The Utilities property view 
appears.

2. Double-click on the Tray Sizing utility. The Tray Sizing view appears.

3. In the Name field, change the name to Kero_SS TS.

 Figure 2.158

Bottom Stage Pressure = Top Stage Pressure + Total 

Section Pressure Drop
(2.1)

Variable Value

Top Stage Pressure 197.9 kPa

Total Section Pressure Drop 24.94 kPa

Bottom Stage Pressure 222.84 kPa

Run Column Solver icon



Refining Tutorial 2-113

2-113

4. Click the Select TS button. The Select Tray Section view appears.

5. From the Flowsheet list, select T-100, then select Kero_SS from 
the Object list. Click the OK button.

6. Click the Auto Section button. The Auto Section Information view 
appears.

7. Select the Valve radio button and click the Next button. 

8. Click the Complete AutoSection button to calculate the Kero_SS 
TS tray sizing parameters.

9. Record the following tray section parameters available on the 
Performance tab in the Results page:

10.Close the Kero_SS TS tray sizing utility.

11.Repeat steps #2-#8 to size the Diesel_SS and AGO_SS side 
strippers.

12.Click the Performance tab, select the Results page, then confirm 
that the following tray section parameters match the table below: 

The pressure drop rating information found in the side stripper tray 

sizing utilities is not used to specify the pressure profile of the Side 

Stripper unit operations. Since there are only three trays in each 

side stripper, the pressure drop across the respective tray sections 

is small. Keeping the pressure profile across the side strippers 

constant does not greatly impact the transition from steady state 

mode to dynamics.

13.Close the Available Utilities view.

You should still be in the Column sub-flowsheet environment. If not, 

double-click the Column T-100 and then click the Column 

Environment button on the bottom of the Column property view.

Variable Kero_SS

Section Diameter 1.676 m

Weir Height 0.0508 m

Tray Spacing 0.6096 m

Total Weir Length 1.362 m

Number of Flow Paths 1

Actual Weir Length (calc) 1.362 m

Variable Diesel_SS AGO_SS 1 AGO_SS 2

Section Diameter 1.676 m 1.067 m 0.6096 m

Weir Height 0.0508 m 0.0508 m 0.0508 m

Tray Spacing 0.6096 m 0.6096 m 0.6096 m

Total Weir Length 3.029 m 0.7038 m 0.5542 m

Number of Flow Paths 2 1 1

Actual Weir Length (calc) 1.515 m 0.7038 m 0.5542 m
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14. In the PFD, double-click the Kero_SS side stripper icon to open its 
property view.

15.Click the Rating tab, then select the Sizing page.

16.Specify the following tray section parameters that were calculated in 
the previous table:

• Section Diameter

• Tray Spacing

• Weir Height

• Actual Weir Length

17.Close the Kero_SS property view.

18.Double-click the Diesel_SS icon, then specify the tray rating 
information using the table on the previous page. Close the property 
view when you are done.

19.Repeat the same procedure to specify the tray rating information for 
AGO_SS.

20.After the column has been specified with the tray rating information, 
converge the column by clicking the Run Column Solver icon in 
the toolbar.

21.Save the case as DynTUT2-2.usc.

Vessel Sizing
The Condenser and Kero_SS_Reb operations require proper sizing 

before they can operate effectively in dynamic mode. The volumes of 

these vessel operations are determined based on a 10 minute liquid 

residence time.

1. Double-click the Condenser icon on the PFD to open its property 

 Figure 2.159

Run Column Solver icon
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view.

2. Click the Worksheet tab, then select the Conditions page.

3. On the Conditions page, confirm the following Liquid Volumetric 
Flow (Std Ideal Liq Vol Flow) of the following streams:

4. Calculate the vessel volume as follows, assuming a 50% liquid level 
residence volume and a 10 min. residence time:

The vessel volume calculated for the Condenser is 88.3 m3.

5. Click the Dynamics tab, then select the Specs page.

 Figure 2.160

Liquid Volumetric Flow Rate (m3/h) Value

Reflux 106.7

Naphtha 152.4

Waste Water 5.736

To Condenser 264.8

(2.2)Vessel Volume
Total Liquid Exit Flow Residence Time

0.5
---------------------------------------------------------------------------------=
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6. In the Model Details group, specify the vessel Volume as 88.3 m3

and the Level Calculator as a Vertical Cylinder.

7. Close the Condenser property view.

8. In the PFD, double-click the Kero_SS_Reb icon to open its 
property view.

9. Click the Worksheet tab, then select the Conditions page.

10. In the Conditions page, confirm that the Liquid Volumetric Flow 
(Std Ideal Liq Vol Flow) for Kerosene is 61.61 m3/h.

Assume a 10 minute of residence time and a 50% liquid level 

residence volume. The vessel volume calculated for the 

Kero_SS_Reb is 20.5 m3.

11.Click the Dynamics tab, then select the Specs page.

 Figure 2.161

 Figure 2.162
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12. In the Volume cell, enter 20.5 m3. In the Level Calculator cell, 
select Horizontal Cylinder from the drop-down list.

13.Close the Kero_SS_Reb property view.

Cooler Volume Sizing
UniSim Design assigns a default volume to each Cooler unit operation 

in the Column sub-flowsheet. In this section you will modify each pump 

around cooler to initialize with a default vessel volume.

1. Double-click the PA_1_Cooler operation in the PFD to open the 
property view.

2. Click the Dynamics tab, then select the Specs page.

3. In the Model Details group, click in the Volume cell, then press 
DELETE. The default volume of 0.10 m3 appears.

4. In the Dynamic Specifications group, ensure that all the 
specification checkboxes are inactive. No dynamic specifications 
should be set for the pump around coolers. 

5. Close the PA_1_Cooler view.

6. Repeat this process for the PA_2_Cooler and the PA_3_Cooler 
operations.

7. Save the case as DynTUT2-3.usc.

2.3.3 Adding Controller 
Operations

Controller operations can be added before or after the transition to 

dynamic mode. Key control loops are identified and controlled using 

 Figure 2.163
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PID Controller logical operations. Although these controllers are not 

required to run the design in dynamic mode, they increase the realism 

of the model and provide more stability.

Adding a Level Controller
In this section you will add level controllers to the simulation flowsheet 

to control the levels of the condenser and reboiler.

First you will install the Condenser controller.

1. If the Object Palette is not visible, press F4.

2. In the Object Palette, click the PID Controller icon.

3. In the PFD, click near the Condenser operation. The controller icon, 
named IC-100, appears in the PFD. 

4. Double-click the IC-100 icon to open the controller property view. 

5. On the Connections tab, click in the Name field and change the 
name of the Controller to Cond LC.

6. In the Process Variable Source group, click the Select PV button, 
then select the information as shown in the figure below. Click the 
OK button when you are done. 

 Figure 2.165

PID Controller icon

For more information 
regarding PID 
Controller, see Section 
12.4.4 - PID 
Controller of the
UniSim Design 
Operations Guide.
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7. In the Output Target Object group, click the Select OP button, then 
select the information as shown in the figure below. Click the OK
button when you are finished. 

8. Click the Parameters tab, then select the Configuration page.

9. Supply the following for the Configuration page: 

10.Click the Control Valve button. The FCV for Reflux view appears.

11. In the Max Flow cell of the Valve Sizing group, enter 2000 kgmole/
h.

12.Close the FCV for Reflux view.

13.Click the Face Plate button. The face plate for Cond LC appears. 

 Figure 2.166

In this cell... Enter...

Action Direct

Kc 4

Ti 5 minutes

PV Minimum 0%

PV Maximum 100%

 Figure 2.167
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For more information 
regarding Face Plates, 
see Section 12.13 - 
Controller Face Plate
in the UniSim Design 
Operations Guide.
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14.Change the controller mode to Auto on the face plate by opening 
the drop-down list and selecting Auto. 

15.Double-click the PV cell, then input the set point at 50%. 

16.Close the Cond LC property view, but leave the face plate view 
open.

17.Repeat the procedures you just learned to add a PID Controller 
operation which serves as the Kero_SS_Reb level controller. Specify 
the following:

18.Click the Control Valve button. The FCV for Kero_SS_Draw view 
appears.

19. In the Valve Sizing group, enter the following

20.Close the FCV for Kero_SS_Draw view.

21.Click the Face Plate button. Change the controller mode to Auto on 
the face plate, then input a set point of 50%. Leave the face plate 
view open.

22.Close the Reb LC property view.

Adding a Flow Controller
In this section you will add flow controllers to the product streams of 

 Figure 2.169

Tab [Page] In this cell... Enter...

Connections Name Reb LC

Process Variable Source Kero_SS_Reb, Liq Percent 
Level

Output Target Object Kero_SS_Draw

Parameters 
[Configuration]

Action Reverse

Kc 1

Ti 5 minutes

PV Minimum 0%

PV Maximum 100%

In this cell... Enter...

Flow Type MolarFlow

Minimum Flow 0 kgmole/h

Maximum Flow 1000 kgmole/h

If you cannot locate a 
stream or operation in 
the Select Input for PV 
view, select the All
radio button in the 
Object Filter group and 
look again.
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the column. These controllers ensure that sufficient material is leaving 

the column.

1. Click the PID Controller icon in the Object Palette, then click in the 
PFD near the Off Gas stream. The controller icon appears.

2. Double-click the controller icon to access the property view. Specify 
the following details:

3. Click the Control Valve button. The FCV for Atmos Cond view 
appears.

4. In the Duty Source group, ensure that the Direct Q radio button is 
selected.

5.  In the Direct Q group, enter the following details:

6. Close the FCV for Atmos Cond view.

7. Click the Face Plate button. The Off Gas FC face plate view 
appears. Change the controller mode to Auto, then input a set point 
of 5 kgmole/h.

8. Close the Off Gas FC property view, but leave the face plate view 
open.

9. In the Object Palette, click the PID Controller icon, then click in 
the PFD near the Diesel stream. The controller icon appears in the 
PFD.

10.  Double-click the controller icon to access the property view. then 
specify the following details:

Tab [Page] In this cell... Enter...

Connections Name Off Gas FC

Process Variable Source Off Gas, Molar Flow

Output Target Object Atmos Cond

Parameters 
[Configuration]3

Action Direct

Kc 0.01

Ti 5 minutes

PV Minimum 0 kgmole/h

PV Maximum 100 kgmole/h

In this cell... Enter...

Minimum Available 0 kJ/h

Maximum Available 2 x 108 kJ/h

Tab [Page] In this cell... Enter...

Connections Name Diesel FC

Process Variable Source Diesel, Liq Vol Flow@Std 
Cond

Output Target Object Diesel_SS_Draw
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11.Click the Control Valve button. The FCV for Diesel_SS_Draw view 
appears.

12. In the Valve Sizing group, enter the following details:

13.Close the FCV for Diesel_SS_Draw view.

14.Click the Face Plate button. The Diesel FC face plate view appears. 
Change the controller mode to Auto and input a set point of 127.5 
m3/h.

15.Close the property view, but leave the face plate view open.

16.Click the PID Controller icon in the Object Palette, then click near 
the AGO stream on the PFD. The controller icon appears.

17.Double-click the controller icon, then specify the following details:

18.Click the Control Valve button. The FCV for AGO_SS_Draw view 
appears.

19. In the Valve Sizing group, enter the following details:

20.Close the FCV for AGO_SS_Draw view.

Parameters 
[Configuration]

Action Reverse

Kc 1

Ti 5 minutes

PV Minimum 0 m3/h

PV Maximum 250 m3/h

In this cell... Enter...

Flow Type MolarFlow

Minimum Flow 0 kgmole/h

Maximum Flow 1200 kgmole/h

Tab [Page] In this cell... Enter...

Connections Name AGO FC

Process Variable Source AGO, Liq Vol Flow@Std 
Cond

Output Target Object AGO_SS_Draw

Parameters 
[Configuration]

Action Reverse

Kc 0.7

Ti 3 minutes

PV Minimum 0 m3/h

PV Maximum 60 m3/h

In this cell... Enter...

Flow Type MolarFlow

Minimum Flow 0 kgmole/h

Maximum Flow 250 kgmole/h

Tab [Page] In this cell... Enter...
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21.Click the Face Plate button. The AGO FC face plate view appears. 
Change the controller mode to Auto and input a set point of 29.8 
m3/h.

22.Close the property view, but leave the face plate view open.

23.Save the case as DynTUT2-4.usc.

2.3.4 Adding Pressure-Flow 
Specifications

Before integration can begin in UniSim Design, the degrees of freedom 

for the flowsheet must be reduced to zero by setting the pressure-flow 

specifications. Normally, you make one pressure-flow specification per 

flowsheet boundary stream, however, there are exceptions to the rule. 

One extra pressure flow specification is required for every condenser or 

side stripper unit operation attached to the main column. This rule 

applies only if there are no pieces of equipment attached to the reflux 

stream of the condenser or the draw stream of the side strippers. 

Without other pieces of equipment (i.e., pumps, coolers, valves) to 

define the pressure flow relation of these streams, they must be 

specified with a flow specification.

Pressure-flow specifications for this case will be added to the following 

boundary streams:

• Atm Feed

• Main Steam

• AGO Steam

• Diesel Steam

• Off Gas

• Waste Water

• Naphtha

• Kerosene

• Diesel

• AGO

• Residue

This simplified column has all the feed streams specified with a flow 

specification. The Off Gas stream has a pressure specification which 

defines the pressure of the condenser and consequently the entire 

column. The liquid exit streams of the column and the side stripper 

operations require pressure specifications since there are no attached 

pieces of equipment in these streams. All the other exit streams 

associated with the column require flow specifications.

The following pump around streams require flow specifications since 

both the Pressure Flow and the Delta P specifications are not set for the 

For more information 
regarding Pressure Flow 
specifications in Column 
unit operations see 
Chapter 8 - Column in 
UniSim Design 
Operations Guide.
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pump around coolers.

• PA_1_Draw

• PA_2_Draw

• PA_3_Draw

The following streams have their flow specifications defined by PID 

Controller operations.

• Reflux

• Kero_SS_Draw

• Diesel_SS_Draw

• AGO_SS_Draw

1. Enter the Main Flowsheet environment. Close the column property 
view if it is still open.

2. Switch to dynamic mode by clicking the Dynamic Mode icon. When 
asked if you want to allow dynamics assistant to identify items 
which are needed to be addressed before proceeding into dynamics, 
click the No button.

Every material stream in the Main Flowsheet requires either a 

pressure or flow specification.

3. Double-click the Diesel Steam icon to enter its property view.

4. Click the Dynamics tab, then select the Specs page.

5. In the Pressure Specification group, clear the Active checkbox.

6. In the Flow Specification group, select the Molar radio button, then 
activate the Active checkbox.

7. In the Molar Flow cell, enter 75.54 kgmole/h if required.

Once a pressure or flow specification has been made active, the 

stream value turns blue and can be modified.

Set the following pressure or flow specifications for the following 

 Figure 2.170

Enter Parent Simulation 
Environment icon

Dynamic Mode icon
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streams in the Main Flowsheet.

8. Use the Object Navigator to enter the Column subflowsheet 
environment. Click the Object Navigator icon in the tool bar. The 
Object Navigator view appears. In the Flowsheets group, double-
click T-100.

Every material stream in the column environment also requires 

either a pressure or flow specification. Use the following procedure 

to set a pressure-flow specification for the PA_1_Draw stream.

9. In the PFD, double-click the PA_1_Draw stream icon to open the 
property view.

10.Click the Dynamics tab, then select the Specs page.

11. In the Flow Specification group, select the Molar radio button, then 
activate the Active checkbox.

12.Close the PA_1_Draw property view.

Material Stream Pressure Specification Flow Specification Value

Atm Feed Inactive Molar Flow, Active 2826 kgmole/h

Main Steam Inactive Molar Flow, Active 188.8 kgmole/h

AGO Steam Inactive Molar Flow, Active 62.95 kgmole/h

Off Gas Active Inactive 135.8 kPa

Waste Water Inactive Molar Flow, Active 317.8 kgmole/h

Naphtha Inactive Ideal LiqVol, Active 152.4 m3/h

Kerosene Inactive Ideal LiqVol, Active 61.61 m3/h

Diesel Active Inactive 211.4 kPa

AGO Active Inactive 215.6 kPa

Residue Active Inactive 221.6 kPa

 Figure 2.171
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13.Activate the following flow specifications for the following streams in 
the Column sub-flowsheet.

14.Save the case as DynTUT2-5.usc.

15.Close all the views except the face plates.

16. To arrange the face plates, select the Arrange Desktop command 
from the Windows menu.

17. The integrator can be run at this point. Click the Start Integrator 
icon. When you are given the option to run dynamic assistant, select 
No.

When the integrator initially runs, UniSim Design detects that no 

vapour phase exists in the Condenser at the specified process 

conditions. It displays the following message:

UniSim Design recommends that you increase the temperature 

setting to create a vapour phase. You can also create a non-

equilibrium vapour phase or set the liquid level to be 100%. For the 

sake of this example, select the default recommendation.

18.Click the Increase Temperature button.

19. Let the integrator run for few minutes so all the values can 
propagate through the column. Observe the value changes on the 
face plate view. 

20. To stop the integrator, click the Stop Integrator icon.

2.3.5 Monitoring in Dynamics
Now that the model is ready to run in dynamic mode, the next step is to 

Material Stream Pressure-Flow Specification Value

PA_2_Draw Molar Flow 830.2 kgmole/h

PA_3_Draw Molar Flow 648.0 kgmole/h

Reflux Molar Flow 879.7 kgmole/h

Kero_SS_Draw Molar Flow 426.6 kgmole/h

Diesel_SS_Draw Molar Flow 616.8 kgmole/h

AGO_SS_Draw Molar Flow 124.8 kgmole/h

 Figure 2.172

Start Integrator icon
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install a strip chart to monitor the general trends of key variables. The 

following is a general procedure for installing strip charts in UniSim 

Design.

1. Open the Databook by using the hot key combination CTRL D.

2. On the Variables tab, click the Insert button. The Variable 
Navigator view appears. 

3. In the Flowsheet list, select the Column T-100.

4. In the Object Filter group, select the UnitOps radio button. The 
Object list is filtered to show unit operations only.

5. In the Object list, select the Condenser. The Variable list available 
for the column appears to the right of the Object list.

6. In the Variable list, select Liquid Percent Level.

7. Click the OK button. The variable now appears in the Databook.

 Figure 2.173

 Figure 2.174

The Variable Navigator 
is used extensively in 
UniSim Design for 
locating and selecting 
variables. The 
Navigator operates in a 
left-to-right manner-
the selected Flowsheet 
determines the Object 
list, the chosen Object 
dictates the Variable 
list, and the selected 
variable determines 
whether any Variable 
Specifics are available.
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8. Add the following variables to the Databook. If you select the top 
variable in the list of Available Data Entries before inserting a new 
variable, the new variable will always be added to the top of the list. 

The next task is to create a Strip Chart to monitor the dynamics 

behaviour of the selected variables.

9. Click the Strip Charts tab in the Databook view.

10.Click the Add button. UniSim Design creates a new Strip Chart with 
the name DataLogger1.

11.Click in the blank Active checkbox beside the Condenser/Liquid 
Percent Level variable.

Object Variable

Kero_SS_Reb Liquid Percent Level

Off Gas Molar Flow

Condenser Vessel Temperature

If you can’t find an Object 
in the Variable Navigator 
view, select the All radio 
button in the Object Filter 
group, then select Case 
(Main) in the Flowsheet 
group. All operations and 
streams for the design 
will appear in the Object 
list.


